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Robotic ControllerManual 

Description of the structure and the functionalities of the robotic controller, focus on 
the parameters to be configured, on the communication protocols and on the 

interface. 
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# Modifica rispetto versione precedente 

1.1 Extension of the explanation to the ZYZ/RPY angles, coupling matrix, SCARA 
kinematics and GUI interface, CodeSys installation and First Launch. 

1.2 Added VISION configuration description for IFM cameras 

1.3 Added CNC profile description (F.Franceschelli) 

1.4 Added FileZilla manual to explain how to get access to the Controller files. 

1.5 Added Update management system (F.Franceschelli) 

1.6 Added camera calibration, Vision system parameters setup and Vision PLC 
FB 

1.7 Added Auxiliary Axes use instructions  

1.8 Added Match Threshold computation instructions 
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 1.Controller initialization 

 1.1.Introduction and general overview 

The Robotic Controller is structured to be a general platform to handle the actuation and 
the control of drives and group of drives (robots, automatic machineries…). To serve that 
purpose the controller can be used with the Graphical User Interface on a host PC (not 
local on the embedded PC) or via CodeSys as platform for PLC programs. 
 
 
The structure of the controller is the following one, on the base of the folders presents 
inside the device: 
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The controller subfolders system can be access using CodeSys, in the “Device (ARC 
Controller)” field, under the “Files” profile it is possible to download and upload files, or 
using a software like “FileZilla” and connecting to the controller using the IP address, user 
name “ftp” and password “ftp”. 
 
Once the User takes access to the controller, the folders here presents contains the 
needed files to use the device: 
 

 1.2.Connection to the Robotic Controller 

 
Software needed: FileZilla (https://filezilla-project.org/download.php?type=client) or 

equivalent FTP client. 
 
 
In order to use correctly the production device, it must be connected with Ethernet cable 
both to the PC and to the robot control board. 

Folder Description 

Cnc That folder contains the files composing the programs of the CNC 
executor. 

Data Contains a text file (*.txt) composed of the LOG of the controller (the 
prints, messages of the controller during execution, that can be also 
visualizes connecting a VGA monitor to the controller) 

Interface Contains the ARC_Gui.exe file (Graphical User Interface executable 
file) needed to launch and use the GUI to command the controller. 

Plc Contains the bonmetLibrary.library file and the  
bonmet_controller.devdesc.xml file to configure correctly the 
CodeSys repositories. 

Config Contains the three configuration files: MOTION, ECAT and VISION 
that must be formatted in the name as “XXX_Config.xml” using 
instead XXX one of the three nomenclature of what the file must 
configure (MOTION, ECAT, VISION), the user must sent here its 
own configuration files with the name explained before. If one file is 
missing the controller cannot be configure correctly so, for example, 
if the VISION modulo isn’t needed, an empty configuration file for 
the Vision part must anyway provide. 

Others files Readme.txt file contain the information here reported on the 
structure of the Robotic Controller; 
Release.txt reports information about the release of the runtime of 
the controller and about the GUI release. 

https://filezilla-project.org/download.php?type=client
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After that, launch the FileZilla application on your PC to download all the files needed from 
the device to the pc. 
Once FileZilla has opened, click on the connection configuration as showed in the Figure 
1.2.1: 

Figure 1.2.1: FileZilla view: open the connection configuration wizard. 
After that, a new window will appear. The user must fill each fields with the following 
indication as showed in Figure 1.2.2:. 
 

-Host address and port number: type the device address (192.168.80.240 in the 
example) and “22” respectively. 
-Connection protocol: click on the arrow on the right and select “SFTP” from the 
menu. 
-Username: “sftp” 
- Password: “sftp” 
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Figure 1.2.2: Connection configuration. 

 
Once every field has been filled, click on “Connect”. 
Now the user should be able to see in the right part of the screen the folders and the files 
contained in the device. 
 
Using FileZilla, ALL these files must be transferred to the user local PC (for example into a 
new folder) as showed in Figure 1.2.3. In this example, a new folder (“Prova device 
produzion”) has been created on the desktop of the local PC, has showed in the bar on the 
left part of the transfer window (C:\Users\arca\Desktop\Prova device produzion). 
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Figure 1.2.3: FileZilla file transfer. 
 
From now on, the user can access to all the device's configuration files, as showed in this 
document. 
Please note that the folder “Interface” contains the Graphical User Interface (GUI): its use 
will be described later on this document too. 
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 1.3.Device Update 

The device’s software can be updated with new packages using the GUI as well. 
 

If the device must be updated, open the GUI without connecting to the device and click on 
Option → Update device as showed in Figure 1.3.1. If the user is already connected to the 
device, just click on the “Disconnect” button on the top-left corner of the GUI and follow the 
above instructions. 

 

 
Figure 1.3.1: Device’s Update command. 

 
 
After clicking on this option, the windows showed in Figure 1.3.2 will appear. 
 
First of all, check the target device by clicking on the “Check target” button on the first row: 
the target IP address should appear in the corresponding box. 
After that, select the software package to be updated by clicking on the “Browse package” 
button on the second row: the package name should appear in the corresponding box. 
If these two operations have been done correctly, the two check symbols will be green. If 
the user finds different symbols, check if the selected device and software package are the 
correct one. 
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Figure 1.3.2: Update window. 
 
In the bottom part of the window, information about the software versions are displayed. 
The first three numbers are related to the software that is currently running on the device, 
while the second three numbers refer to the software to be updated. 
 
If the information are correct, click on the “UPDATE_TARGET” button in the center of the 
window to update the device. 
 
Once the update has finished, the information about the two software must be the same. 
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 1.4.Configure Network 

To correctly configure the network (IP address, Mask and EtherCAT addresses) it is 
possible to operate from the GUI, in the main BMC profile and change the parameters that 
the User wants to edit. 
 

 
 
Once configured all the parameters, the User can press the “Ok” button and starts to use 
the Robotic Controller as explained in the following. 
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 1.5.Download data to theController 

To setup the Configuration files needed to initialize the Robotic Controller, it is possible 
from the GUI (Graphical User Interface) to change them, localizing the file on the computer 
that host the GUI, load them, open to check if everything is correct and save that files in 
the controller. 
 

 Localize in the BMC profile of the GUI (to see deeper explanation regarding 
Graphical User Interface, see Chapter 5) the button to open the wizard to “Load 
New Configuration Files”. 

 
 

 After press the “Load New Configuration Files” button, a wizard opens and allow the 
User to choose the files to be loaded and used as default Configuration inside the 
controller and also so open them and see them: 
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 Each Configuration file (ECAT, MOTION, VISION) must be loaded: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



  16/87 
 

Robot Controller: User Reference Manual 
 

 Once the files have been selected, they can be opened in the GUI wizard to check if 
everything is ok and after that, with “DONE” command they can be stored inside the 
Controller: 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 After the Configuration files have been loaded correctly, to see them work the 
Controller must be rebooted, using the devoted procedure: push the “Reboot 
Device” button and press “YES” 
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 1.6.CodeSys setup 

To creates a PLC program and use the blocks of the ArcaLibrary in order to create 
applications and motion profile for the robots and in general for drives, it is necessary to 
install CodeSys PLC programming environment and configure the connection with the 
Robot Controller. 
 
First the User needs to install CodeSys on the host PC used to control the embedded 
controller, following the procedure: 
 

 Launch “Setup_CODESYSV35SP8.exe” to start the installation wizard of the 
application; 

 Follow installer instructions, using STANDARD setting and usage. 
 
After the installation of the software utilities, the User must install the Controller device 
inside the Device Repository and the ArcaLibrary with all the blocks to use the controller, 
inside the Library Repository, following the procedure: 
 

 Launch CodeSys v3.5.8.1; 

 Select in the tool bar the menu “Tools -> Device Repository” and click on “INSTALL”, 
select the file “ARC_Controller.devdesc.xml” on the User’s PC, and the ARC 
Controller object will be added in the repository. 

 

 After adding the repository, exit by clicking “DONE”.  
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 To install the library inside the devoted repository, in the menu bar select “Tools -> 
Library Repository”, click on install and select the file “ArcaLibrary_compiled-library”.  

 

 Once the procedure of adding the library is done, click again on “CLOSE” to exit. 
 
 

Please pay attention to the library adding procedure: if the User wants to open a project 
and needs to update the ArcaLibrary release, could be necessary to repeat the procedure 
of repository install deleting before the old installation, as reported in the further steps: 
 

 Under the project open, browse to find “Library Manager” and check the open 
windows on the right: select ArcaLibrary installed and click on “Delete Library”: 
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 After deleted ArcaLibrary, click on “Add Library” and on the opened library, click on 
“Advanced...” 

 

 Open the Library Repository and browse to find in the host PC the 
ArcaLibrary.library that the User wants to install and select it: 

 
 

 After adding the new library, it must be visible in the “Library Repository” window. 
Once done that procedure, close all the windows and re-click the “Add Library” 
button to open the adding procedure, now click on “Miscellaneous” and select the 
Arca Motion Library the User wants to use (the installed one). 
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 Once the library has been installed, on the menu bar, select “Build” and a menu 
window will open, click on “Clean All” and “Yes” on the pop-up window that appears. 
After that, click on “Build” command and CodeSys will compile all the project. 

 If no errors occurred, the User can now launch the project as will be explain in the 
next Section. 
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 1.7.First application running 

To launch the first application follows the instructions in CodeSys, after the setup of the 
repositories: 

 Select “File -> Open Project” and open project file “TEST_PickAndPlace.project”; 

 Select “Build -> Rebuild all” (if some problems arises with the library follow the steps 
for delete and re-add the library explained in the previous Section). 

 Select node “Device (ARC_Controller)” -> right click -> Edit Object, the device 
connection window will be opened and appear like the one reported below: 

 

 Insert the address of the controller into the highlighter box and press Enter, if 
controller is recognized, the GREEN light will be turned on, otherwise an error 
message “No device is responding to the scan request” will be shown: in this case 
check controller settings and cabling. 
 

 Double click on “MAIN (PRG)” to open the main project page. 
 

 Select “Online -> Login”: the environment will compile project, download to the 
target and change the view into online mode. 

 

 On the variable list, in “PREPARED VALUE” column, double click in the “POWER” 
variable row and CodeSys made appear a blue box “TRUE”. 
 

 Write value to controller selecting “Debug -> Write values” (or pressing CTRL+F7). 
 

 The robot will switch on (notice the change of variable “Powered”). 
 

 Change value of variable “CYCLE” in TRUE and write it to controller, the robot will 
starts doing a Pick And Place test movement. 
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(Example of the CodeSys execution window where it is possible to change values of 
variables) 
 

 1.8.Variable trace in CodeSys 

When running a CodeSys application, it is possible to trace the used variables in order to 
have a better understanding about how they are evolving.   

Traces can be easily configured as additional objects inside the application.  

 a)1.8.1 Trace Configuration 

After opening the CodeSys application, right click on the left tree menu on “Application”. 
Select “Add object”--> Trace, as showed in Figure 1.8.1.  
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Figure 1.8.1 Trace creation  

Select the name of the trace and click “Ok”. Select the created trace and open the 
Trace Configuration. In the new window select the task to be associated to the trace 
as showed in Figure 1.8.2.  
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Figure 1.8.2 Trace configuration  

 

After selecting the task, there are many other options that can be selected. The trigger 
configuration could be very useful to detect a particular condition when running the 
application: it is possible to select a variable to be associated to the trigger, the edge of 
detection (positive, negative or both), a number of samples to be recorded after the trigger 
detection and also a Trigger level.  

In the example above, a trigger has been associated to the boolean variable 
ToolMoveAbs6.Done of the main program PLC_PRG. The trigger will be detected 
when this variable will turn from FALSE to TRUE (positive edge) and it will record 
300 samples after the trigger detection.  

Once the general configuration has been done, the user can proceed to add the 
variables to be traced. Click on “Add variable” in the bottom left corner (Figure 1.8.3).  
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Figure 1.8.3 Add variable to the trace  

First of all select in the corresponding field the variable to be traced.  

After that, many graphical options could be selected, like colors, line type, point type for 
each sample and critical limits.  

In the example above, the variable AxisPosition1 of the main program PLC_PRG will 
be traced. The graph color will be green, and each sample will be visualized as a dot 
linked to the other through a line. Minimum and maximum warnings has been 
configured as well: once the selected variables will assume values below 20, the 
samples dot will be colored in OrangeRed, while if the variable will assume values 
above 60, the samples dot will be colored in Red.  

Please remark that not all the PLC program variables can be plotted in a trace: for 
example, the element of an array can not be plotted. If the user find himself unable 
to plot a variable, try to create a new global variable inside the PLC program, assign 
the value of the old variable to the new one, and try to plot the new variable.   

Example: let’s suppose that the positions of a robot have been stored inside the 
PLC program into an array Robot_Positions=[Pos_X, Pos_y, Pos_Z, Rot_A, Rot_B, 
Rot_C]. In this way the robot positions can not be plotted in a trace… But, if the user 
assigns the positions to a new variable outside the array, it is possible to trace the 
new variable.   

Position_X : REAL;  
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Position_X := Robot_Positions[0];  
The new variable Position_X can be plotted inside the trace!  

 

 b)1.8.2 Trace Visualization 
 

Once the trace has been configured, run the PLC application. Open the created 
trace, right click on the graph and select “Download trace”. In this way the traced 
variables will be updated while the application is running.  
 

In Figure 1.8.4 are showed the traced variables configured in the example above.  
 

 

Figure 1.8.4 Variable trace example  

 

The first variable (in blue) is the same variable associated to the trigger 
(PLC_PRG.ToolMoveAbs6.Done): as can be seen, once the variable turns from 0 
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(FALSE) to 1 (TRUE) the trigger has been released (vertical thick black line) and the 
record duration starting from that instant is about 6 seconds (300 samples).  

The second variable (in green) is the variable for which maximum and minimum 
limits have been configured (AxisPosition1). As can be seen in the Figure, once the 
variable's value exceeds these limits, the samples turn from green to red.  

Once the trace has been done, there are many options that can be used. By right clicking 
on the trace, it is possible to add a cursor, in order to scroll the values of each traced 
variable (in the example above, the added cursor is the vertical thin black line with an 
arrow above).  

It is also possible to save the trace in both .trace and .txt format, or load a previously 
saved trace (right click on the trace and select “Save Trace” or “Load Trace”).   
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<Drive> 
<Name>Drive 1</Name> 
<Type>VIRTUAL</Type> 
<EncResolution>131072</EncResolution> 
<GearRatioNum>121</GearRatioNum> 
<GearRatioDen>1</GearRatioDen> 

<RotorInertia>0.0035e-4</RotorInertia> 
<AxisStructure>PRISM</AxisStructure> 

<PosScalingNum>360.0</PosScalingNum> 
<PosScalingDen>1.0</PosScalingDen> 
<SpeedScalingRatio>1.0</SpeedScalingRatio> 
<AccelScalingRatio>1.0</AccelScalingRatio> 
<PosInversion>FALSE</PosInversion> 
<PosLimitEnable>TRUE</PosLimitEnable> 
<PosLowerLimit>-170.0</PosLowerLimit> 
<PosUpperLimit>+170.0</PosUpperLimit> 
<MotorNominalTorque>0.318</MotorNominalTorque> 
<MaxSpeed>140.0</MaxSpeed> 
<ReducedSpeedPerc>100.0</ReducedSpeedPerc> 
<MaxAccel>1400.0</MaxAccel> 
<MaxDecel>1400.0</MaxDecel> 
<MaxJerk>14000.0</MaxJerk> 
<HomingMethod>35</HomingMethod> 
<HomeOffset>0.0</HomeOffset> 
<HomingSwitchSpeedPerc>10.0</HomingSwitchSpeedPerc> 
<HomingIndexSpeedPerc>5.0</HomingIndexSpeedPerc> 
<HomingAccelPerc>10.0</HomingAccelPerc> 
<HomingTimeoutMs>30000</HomingTimeoutMs> 
</Drive> 

 2.Controller configuration files: MOTION 

 2.1.XML file structure 

The motion configuration file is written in Extensible Markup Language (XML) that is a 
markup language that defines a set of rules for encoding documents in a format which is 
both human-readable and machine-readable. 
 
Inside the robotic controller, the “MOTION_DefaultConfig.xml” file represent the user set 
up for the robot control: it contains information about the axis configured, composing the 
actuation part of the robot, about both kinematic and dynamic description of the robot in 
use, and others information, such as Work Space speed, acceleration and jerk limits, offset 
and translation before and after the robot structure and so on. 
 
In the following, the purpose of the MOTION_DefaultConfig.xml file will be explained, 
dividing the task in two macro sections: Drive and AxesGroup. 
 

 2.2.Drive List 

This is the first part of the file, containing the information of all the drives configured. 
The following Table report an example of the structure of a “DRIVE” element of the Drive 
List, with all the parameters to be configured: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Table 2.1: Syntax and 
Drive set up example. 
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All the elements contained inside the command <Drive> and </Drive> are referred to one 
axis, the following table explain the parameters to be used: 
 

Parameters Description Type Value 
EXAMPLE 

Name Name of the Drive: must be 

consistent to the one reported in 

the ECAT_DefaultConfig.xml file 

char Drive1 

Type Tells the controller is the axis is 

real (COE) or it is simulated 

internally (VIRTUAL). A simulated 

axis doesn’t act any 

communication with the drive 

AxisType COE 

EncResolution Encoder resolution in a drive 

revolution 

int32 131072 

GearRatioNum Gearbox parameter: motor 

revolution 

in32 121 

GearRatioDen Gearbox parameter: load 

revolution 

int32 1 

RotorInertia Inertia of the motor before gear 

redactor 

double 0.0035e-4 

AxisStructure Tells if the axis must be 

considered as linear (i.e. 

displacement in meters), or 

revolute (default option). 

AxisStruct 

(PRISM, 
REV) 

PRISM 

PosScalingNum Scaling of the position after the 

gearbox, position units 

double 360.0 

PosScalingDen Scaling of the position: load 

revolution 

int32 1.0 

SpeedScalingRatio increments/second times drive 

velocity unitary value 

double 1.0 

AccelScalingRatio increments/second^2 times drive 

acceleration unitary value 

double 1.0 

PosInversion Invert the position given to the 

drive from the controller and vice 

versa 

uint8 FALSE 

PosLimitEnable Enable the usage of joint limits uint8 TRUE 

PosUpperLimit Upper limit of the joint after 

gearbox 

double -170.0 

PosLowerLimit Lower limit of the joint after 

gearbox 

double +150.0 

MotorNominalTorque Nominal torque of the motor double 0.318 
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actuating the joint 

MaxSpeed Maximum speed the joint can 

achieve after the gearbox, 

units/second 

double 140.0 

ReducedSpeedPerc Percentage of maximum speed 

to be used 

double 100.0 

MaxAccel Maximum acceleration the joint 

can achieve after the gearbox,  

units/second^2 

double 1400.0 

MaxDecel Maximum deceleration the joint 

can achieve after the gearbox, 

unit/second^2 

double 1400.0 

MaxJerk Maximum jerk the joint can 

achieve after the gearbox, 

unit/second^3 

double 14000.0 

HomingMethod Homing method necessary to set 

a new zero position for the axis 

(CANopen specification) 

uint8 35 

HomeOffset Units offset that can be added to 

the homing position set up 

double 0.0 

HomingSwitchSpeedPerc Percentage of the MaxSpeed to 

be used in the homing procedure  

double 10.0 

HomingIndexSpeedPerc Percentage of the MaxSpeed to 

be used in the homing procedure  

double 5.0 

HomingAccelPerc Percentage of the MaxAccel to 

be used in the homing procedure 

double 10.0 

HomingTimeoutMs Time to complete the homing 

procedure in millisecond 

uint32 30000 

 
It is important to remark that the name of the drive must be the same of the correspondent 
section of the “ECAT_DefaultConfig.xml” file, otherwise the communication cannot be set 
up. 
 
To use a virtualization of the axis, 
without any real actuation of 
commands outside the controller, 
the Type field must be fitted with 
“VIRTUAL” instead “COE” that 
represent the command for real 
axis actuation. 

                Figure 2.1: Representation of the Drive,  
Gear-reductor, Linear movement transformation 
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The PosInversion parameters must be correctly set up on the base of the indication 
regarding the robot kinematics in use, in case of a group of axis. A wrong value can lead to 
an error and unwanted movement of the mechanism. 
 

 2.3.AxesGroup List 

This section contains the AxesGroups formed by the user, grouping all or some of the 
Drive initialized in the DriveList section.The section is encoded with the command 
<AxesGroup> and </AxesGroup> and can also contain nothing but the identification of the 
list must be present. 
 
The main parameters of a single AxesGroup are the name and the kind of robot structure 
used, the list of drives composing the group and the kinematic parameters of the 
mechanical structure. 

Parameters Description Type Value EXAMPLE 

Name Name of the 

AxesGroup 

char BonmetYellow3Kg 

Kinematic Structure 

containing all the 

user defined 

parameters of a 

robot, such as 

drive list 

composing the 

actuation part of 

the robot, 

geometric 

parameters and 

dynamic ones. 

structure reference to Table 3.2 

BaseOffset Roto-translation 

that can be 

applied to the 

base of the robot 

(BEFORE the 

kinematic 

structure), 

composed by: 

- Linear 

displaceme

nt (X,Y,Z) 

- Rotation 

structure structure of double 
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around 

main axes 

(A,B,C) 

ToolOffset Roto-translation 

that can be 

applied to the end 

of the robot 

(describing for 

example the 

TOOL/END 

EFFECTOR 

dimensions, 

AFTER the robot 

kinematic), 

composed by: 

- Linear 

displaceme

nt (X,Y,Z) 

- Rotation 
around 
main axes 
(A,B,C) 

structure structure of double 

MaxSpeed Maximum Work 

Space speed of 

the tool/End 

Effector [m/s] 

double 1.0 

MaxAccel Maximum Work 

Space 

acceleration of the 

tool/End Effector 

[m/s^2] 

double 10.0 

MaxJerk Maximum Work 

Space jerk of the 

tool/End Effector 

[m/s^3] 

double 100.0 

AnglesMode Representation of 

the angles A,B,C 

to be used: can 

be Euler (ZYZ) or 

Roll, Pitch and 

char ZYZ 
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The Table 3.1 reports the main sections and parameters of a typical AxesGroup, then in 
the following specific example of each kinematics AxesGroup will be reported. 

The Kinematic structure contains different kind of parameters on the base of the robot 

structure that are used, in the following the supported Kinematic structures will be 

explained and presented with examples about the configuration parameters. 

 2.4.AnglesMode 

Rotation matrices gives the representation of the orientation in the Work Space (Cartesian 
space of work) are composed by nine elements computed starting from two possible 
rotation conventions to represent the three angles that represent orientation: Euler or Roll, 
Pitch and Yaw. 

 a)Euler angles 

A representation of orientation in terms of three independent parameters constitutes a so-
called minimal representation that can be obtained using a set if three angles Φ=[φ, ϑ, ψ]. 

The rotation described by ZYZ angles is obtained as composition of elementary rotations: 

 Rotate reference frame by angle φaround Z axis; 

 Rotate reference frame by angle ϑaround Y axis; 

 Rotate reference frame by angle ψaround Z axis. 

The resulting rotation composition follows in Figure 3.1.1: 

Yaw (RPY) 

Coupling 

 

Coupling matrix 

that allow to 

decouple via 

software the joint 

movement and 

solve the 

kinematic. It is a 

square matrix with 

dimension the 

number of joints. 

matrix 

(NJoint 

x 

NJoint) 

<Coupling><Row1>1.0;0.0;0.0;0.0</Row1><Row2>0.0;1.0;0.0;0.0</Row2> 
<Row3>0.0;0.0;1.0;-0.4</Row3><Row4>0.0;0.0;0.0;1.0</Row4> 
</Coupling> 
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Figure 3.1.1: Euler ZYZ rotation angles. 
 

 b)Roll, Pitch and Yaw angles 

A Euler angles-derived representation is the aeronautical well known Roll, Pitch and Yaw 
convention. That angles, named ZYX denote typically the rotations around main axis of a 
reference frame fixed on the object that must be described in orientation in the Work 
Space. 

The rotations resulting from Roll, Pitch and Yaw angles can be obtained as composition of 
the following elementary steps: 

 Rotate reference frame by angleψaround X axis (Yaw); 

 Rotate reference frame by angle ϑaround Y axis (Pitch); 

 Rotate reference frame by angle φaround Z axis (Roll). 

Figure 3.1.2 shows the composition of RPY (Roll, Pitch and Yaw) angles: 

 

Figure 3.1.2: Roll, Pitch and Yaw angles composition. 
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 c)Example of angles representation 

Both the representations for the zero position of the anthropomorphic robot with spherical 
wrist (i.e.) present the same orientation to reach all joint to zero angular displacement: 

T = [X, Y, Z, 0.0°, -90.0°, -180.0°] 

If the user wants to orientate robot with the End-Effector parallel to the plane XY (down, in 
a pick/place position i.e.) the orientation becomes in ZYZ angles: 

T = [X, Y, Z, 0.0°, -180.0°, -180.0°] 

In that way the orientation of the wrist can be controlled using the ZYZ or RPY angles, 
taking into account that the Work Space angles ARE NOT the joint angles of the robot. 

 

 2.5.Coupling Matrix 

It allows the definition in the Motion Configuration file of the Coupling matrix, that made 

possible the matching and un-matching of multi axis and rotations movement regarding the 

same joint: i.e. if the wrist revolute joint actuates also a translation, it is possible, thanks to 

that matrix, to take into account of that unwanted displacement and compensate it with 

another joint. In that way the controller see always the axis decoupled one from each 

other’s actuating only a revolution or a translation. 

The mathematical structure of the Coupling matrix is the following one, reported in the 

Table 3.2.1 and showing with operation the matrix actuates on the joint position array: 

 Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 

Axis 1 =  a1*Axis1 + a2*Axis2 +  a3*Axis3 + a4*Axis4 +  a5*Axis5 + a6*Axis6 

Axis 2 = b1*Axis1 + b2*Axis2 + b3*Axis3 + b4*Axis4 + b5*Axis5 + b6*Axis6 

Axis 3 =  c1*Axis1 + c2*Axis2 + c3*Axis3 + c4*Axis4 + c5*Axis5 + c6*Axis6 

Axis 4 =  d1*Axis1 + d2*Axis2 + d3*Axis3 + d4*Axis4 + d5*Axis5 + d6*Axis6 

Axis 5 =  e1*Axis1 + e2*Axis2 + e3*Axis3 + e4*Axis4 + e5*Axis5 + e6*Axis6 

Axis 6 = f1*Axis1 +  f2*Axis2 + f3*Axis3 + f4*Axis4 + f5*Axis5 + f6*Axis6 

Table 3.2.1: Coupling matrix concept and computational structure. 

As it is possible to see from Table 3.2.1, the coupling matrix is composed by the 

coefficients that allows one to get the decoupled angles of the kinematic structure: 
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The matrix must be setted in the Motion configuration file, where is a field of the 

AxesGroup and wants a set of rows per each joint, with the coefficients separated by “;” or 

“,” character. If a number of configured rows less than the axis composing the AxesGroup 

are defined, errors will be returned and the kinematic is not well initialized. 

If the Coupling matrix is not defined in the configuration file, the controller will initialize it to 

the identity, that means no effect of coupling on the kinematic computation. 

 2.6.AxesGroup configuration for the supported robot kinematics 

 a)Anthropomorphic Robot (6-axis) 

This robot is one of the most well-known structure and wide used. It is composed by a 
three-joint arm mechanism that act the movement along Cartesian displacement (X,Y,Z) 
and by a three-joint spherical wrist that act all the rotations in the Space (A,B,C) around 
the main axis on the base of the convention used to interpret angular movement. 
 
The kinematic model of that mechanism is based on the following convention: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.1.1: Anthropomorphic arm parameters and joint rotation directions. 
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The geometric lengths of the links needed in the computation of the Kinematic model of 
the robot are represented in Figure 4.1.1 and marked as LX, they are expressed in meters 
[m]. 
 
The joints named “aX” are signed with the revolute directions. The pose in the figure are 
the one the robot assumes with all joints to zero position. 
 
There are two types of kinematic solver implemented in the controller for that kinematics, 
one recursive and the other one in closed form, this gives to the user the possibility to 
choose the dexterity of the robot (means up elbow, low wrist, and so on) or to have a 
standard recursive solver. 
 
 

Parameters Description Type (Values EXAMPLE) 
KinType Describe the type 

of kinematic in use, 

must be a default 

value to be 

interpret correctly 

by the software 

Recursive solver: 

- Anthrop6_Rec 

Closed-form solver: 

- Anthrop6_Cf 

DriveNameList List of drives 

composing the 

actuation part of 

the robot, must be 

fed with exactly the 

same name given 

to the 

correspondent 

drive in the 

DriveList section 

and in ECAT 

configuration file 

<DriveNameList><DriveName>Drive1</DriveName><DriveName>Drive2</DriveName><DriveName>Drive3</DriveName><DriveName>Drive4</DriveName><DriveName>Drive5</DriveName><DriveName>Drive6</DriveName></DriveNameList> 

Params Description of the 

parameters used to 

construct both 

kinematic and 

dynamic model 

 

- Geometric 

parameters 

Lengths of the links 

reported in the 

Figure 4.1.1 in [m] 

<L1>0.320</L1> 
<L2>0.270</L2> 
<L2b>0.00</L2b> 
<L3>0.070</L3> 
<L4>0.299</L4> 
<L5>0.0785</L5> 
<L6>0.05</L6> 
<L7>0.00</L7> 
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- Dynamic 

parameters 

Dynamic 

parameters 

needed to 

construct the 

Dynamic model of 

the robot: 

- Viscous 

friction: 

relative to 

the joint 

[Nm*rad/s] 

- Static 

friction: 

relative to 

the joint 

[Nm] 

- Dynamic 

friction: 

relative to 

the joint 

[dimensionle

ss] 

- Masses: of 

each link 

composing 

the robot 

[Kg] 

- Center of 

mass’s 

position: 

Cartesian 

position of 

the center of 

mass of 

each link 

(with inside 

the motors), 

along X,Y,Z 

[m] 

- Inertia 

tensor’s 

elements: 

- Viscous friction 

<b1>0.0</b1> 

… 

<b6>0.0</b6> 

- Static friction 

<f1>0.0</f1> 

… 

<f6>0.0</f6> 

- Dynamic friction 

<f_w0_1>0.0</f_w0_1> 

… 

<f_w0_6>0.0</f_w0_6> 

- Masses 

<m1>0.0</m1> 

… 

<m6>0.0</m6> 

- Center of mass’s position 

<r2x>0.0</r2x> 

<r2y>0.0</r2y> 

<r2z>0.0</r2z> 

- Inertia tensor’s elements 

<I2xx>0.0</I2xx> 

<I2yy>0.0</I2yy> 

<I2zz>0.0</I2zz> 

<I2xy>0.0</I2xy> 

<I2xz>0.0</I2xz> 

<I2yz>0.0</I2yz> 
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main and 

deviation 

terms of 

inertia of 

each link 

with respect 

to the axis 

X,Y,Z of the 

position of 

the center of 

mass. 

 

Table 4.1.1 shows the parameters to be set up for the 6-Joints Anthropomorphic robot 
using both recursive and closed-form kinematic solver. 

 

 

It is important to remark that the inversion of the drives must be set up accordingly to the 

AxesGroup kinematics that the user wants to use. In the 6-axis anthropomorphic robot the 

inversions scheme is the following of Table 4.1.2: 

 

Drive1 Drive2 Drive3 Drive4 Drive5 Drive6 

FALSE FALSE FALSE FALSE TRUE TRUE 

 

Table 4.1.2: Inversion of the axis in the DriveList, accordingly to AxesGroup 

anthropomorphic robot. 
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 b)Delta (Parallel) Robot (3-axis) 

The parallel robotic structure, known as Delta robot, is composed by three leg, actuated by 
three joints and two links connected to a unique moving platform. 

 
 

Figure 4.2.1: Delta robot geometrical parameters and joints rotation directions. 
 

Parameters Description Type (Values EXAMPLE) 
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KinType Describe the type 

of kinematic in use, 

must be a default 

value to be 

interpret correctly 

by the software 

Closed-form solver: 

- Delta3_Cf 

DriveNameList List of drives 

composing the 

actuation part of 

the robot, must be 

fed with exactly the 

same name given 

to the 

correspondent 

drive in the 

DriveList section 

and in ECAT 

configuration file 

<DriveNameList><DriveName>Drive1</DriveName><DriveName>Drive2</DriveName><DriveName>Drive3</DriveName></DriveNameList> 

Params Description of the 

parameters used to 

construct both 

kinematic and 

dynamic model 

 

- Geometric 

parameters 

Lengths of the links 

reported in the 

Figure 4.2.1 in [m] 

<LA>0.127</LA> base radius 
<LB>0.180</LB> short leg length 
<LC>0.000</LC> elbow displacement  
<LD>0.450</LD> long leg length 
<LE>0.000</LE> tool displacement 
<LR>0.0625</LR> tool radius 

- Dynamic 

parameters 

Dynamic 

parameters 

needed to 

construct the 

Dynamic model of 

the robot: 

- Viscous 

friction: 

relative to 

the joint 

[dimensionle

ss] 

- Static 

friction: 

- Viscous friction 

<B>0.0</B> 

- Static friction 

<F>1.36</F> 

- Dynamic friction 

<F_W0>0.0</F_W0> 

- Masses 

<MT>0.220</MT> 

<MR>0.287</MR> 

<ME>0.250</ME> 

<MC>0.020</MC> 
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relative to 

the joint 

[dimensionle

ss] 

- Dynamic 

friction: 

relative to 

the joint 

[dimensionle

ss] 

- Masses: of 

each link 

and element 

composing 

the robot 

[Kg] 

 
Table 4.2.1: Description of the parameters for the 3-axis Delta robot. 

 
Inversion flag for the drive of the Delta robot must follow the Table 4.2.2 to avoid unwanted 
movement: 

Drive1 Drive2 Drive4 

FALSE FALSE FALSE 
 

Table 4.2.2: Inversion of the axis in the DriveList, accordingly to AxesGroup Delta robot. 
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 c)Cartesian Robot (3-axis) 

Parallel Cartesian robot: acts movement along X,Y,Z direction with three joints, as reported 
in Figure 4.3.1: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.3.1: Cartesian robot geometrical parameter. 
 

In the Table 4.3.1 the parameters needed in the set-up of the Cartesian’s AxesGroup are 
presented: 
 

Parameters Description Type (Values EXAMPLE) 
KinType Describe the 

type of 

kinematic in 

use, must be 

a default 

value to be 

interpret 

correctly by 

the software 

Closed-form solver: 

- Cartesian (Recursive only) 

DriveNameList List of drives 

composing 

the actuation 

part of the 

robot, must be 

fed with 

exactly the 

same name 

<DriveNameList><DriveName>Drive1</DriveName><DriveName>Drive2</DriveName><DriveName>Drive3</DriveName></DriveNameList> 
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given to the 

correspondent 

drive in the 

DriveList 

section and in 

ECAT 

configuration 

file 

Params Description of 

the 

parameters 

used to 

construct both 

kinematic and 

dynamic 

model 

(Up to now only kinematic model are implemented) 

- Geometric 

parameters 

Lengths of the 

links reported 

in the Figure 

4.3.1 in [m] 

<LA>0..0</LA>displ. of first axis 
<LB>0..0</LB> displ. of second axis 
<LC>0.0</LC> displ. of third axis 

 
Table 4.3.1: Description of the parameters for the 3-axis Cartesian robot. 

 

 d)SCARA Robot (4-axis) 

Serial robot with planar arm and roto-translating wrist, that actuate a movement along Z 
axis up and down and control the orientation of the tool around Z axis again. 
 
There are three type of SCARA robot supported: the discriminant of the types is the 
position of the prismatic joint, if first, third or fourth. 

 
Figure 4.4.1: SCARA robot generic parameters representation. 
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The prismatic joint can be considered as first, moving all the robot along Z axis, or in 
third/fourth position, switched with the rotational axis around Z but keeping the first and 
second axis as the planar arm actuators. 
 
The kinematic is recognized automatically by the controller on the base of the position of 
the prismatic (“PRISM”) drive in the configuration file. 
If there are configured more than one prismatic axis, of course the kinematic controller will 
return error. 
 
In the Table 4.4.1 the parameters needed in the set-up of the Cartesian’s AxesGroup are 
presented: 
 

Parameters Description Type (Values EXAMPLE) 
KinType Describe the type 

of kinematic in use, 

must be a default 

value to be 

interpret correctly 

by the software 

Closed-form solver: 

- Scara4_Cf 

- Scara4 

DriveNameList List of drives 

composing the 

actuation part of 

the robot, must be 

fed with exactly the 

same name given 

to the 

correspondent 

drive in the 

DriveList section 

and in ECAT 

configuration file 

<DriveNameList><DriveName>Drive1</DriveName><DriveName>Drive2</DriveName><DriveName>Drive3</DriveName><DriveName>Drive4</DriveName></DriveNameList> 

Params Description of the 

parameters used to 

construct both 

kinematic and 

dynamic model 

 

- Geometric 

parameters 

Lengths of the links 

reported in the 

Figure 4.4 in [m] 

<LA>0.300</LA> 
<LB>0.300</LB> 
<LZ>0.220</LZ> 

- Dynamic 

parameters 

Dynamic 

parameters 

needed to 

- Static friction 

<f1>0.0</f1> 

… 

<f6>0.0</f6> 
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construct the 

Dynamic model of 

the robot: 

- Static 

friction: 

relative to 

the joint 

[dimensionle

ss] 

- Dynamic 

friction: 

relative to 

the joint 

[dimensionle

ss] 

- Dynamic friction 

<f_w0_1>0.0</f_w0_1> 

… 

<f_w0_6>0.0</f_w0_6> 

 

Table 4.4.1 shows the parameters to be set up for the 4-Joints SCARA robot using closed 
form kinematic. 

 
The coupling matrix must take into account the fact that the rotational joint acts in some 
case (depending on the mechanical structure of the robot) also a translation related to the 
rotation. It’s possible in that way to compensate it with the prismatic joint. 
 
 
Inversion flag for the drive of the SCARA robot must follow the Table 4.4.2 to avoid 
unwanted movement: 

Drive1 Drive2 Drive3 Drive4 

TRUE TRUE TRUE TRUE 
 

Table 4.4.2: Inversion of the axis in the DriveList, accordingly to AxesGroup Delta robot. 
 
 
 

e)PALLETIZER Robot (4-axis) 

This robot has a configuration similar to the anthropomorphous robot: it is composed 
by a three-joint arm mechanism that act the movement along Cartesian 
displacement (X,Y,Z), but the wrist is composed only by one joint that gives an 
additional rotation around the Z axis.  
Thanks to its particular mechanical structure, the end effector terminal is always kept 
parallel to the X-Y plane, so the wrist can rotate only around the Z axis thanks to its 
one and only joint.    
The kinematic model of this mechanism is based on the following convention:  
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Figure 2.6.e.1 Palletizer arm parameters  

 

The geometric lengths of the links needed in the computation of the Kinematic model 

of the robot are represented in Figure 2.6.e.1 and marked as LX. They are 

expressed in meters [m].  

 

The joints named “aX” are signed with the revolute directions. The pose in the figure 
are the one the robot assumes with all joints to zero position.  
 

Unlike the anthropomorphous robot, the Palletizer can’t assume different 

configuration of the arm to reach the same point: the only two available configuration 

are defined by the fourth joint (the wrist joint) and differ one another about a 180° 

rotation along the Z axis.  
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Parameters  Description  Type (Values EXAMPLE) 

DriveNameList  List of drives 

composing the 

actuation part 

of the robot, 

must be fed 

with exactly the 

same name 

given to the 

correspondent 

drive in the 

DriveList 

section and in 

ECAT 

configuration 

file  

<DriveNameList> 
<DriveName>Drive1</DriveName><DriveName>Drive2</DriveName> 
<DriveName>Drive3</DriveName> 
<DriveName>Drive4</DriveName> 
</DriveNameList> 

Params  Description of 

the parameters 

used to 

construct both 

kinematic and 

dynamic model  

 

-  Geometric 

parameters  

Lengths of the 

links reported 

in the Figure 

2.6.e.1 in [m]  

<L1>0.420</L1> 
<L2>0.90</L2> 
<L3>1.300</L3> 
<L4>1.300</L4> 
<L5>0.300</L5> 
<L6>0.300</L6> 

 

Table 2.6.e.1 shows the parameters to be set up for the 4-joints Palletizer robot  

 

 

It is important to remark that the inversion of the drives must be set up accordingly to 

the AxesGroup kinematics that the user wants to use. In the 6-axis anthropomorphic 

robot the inversions scheme is the following of Table 2.6.e.2:  

 

 e) Drive1  Drive2  Drive3  Drive4 

FALSE  FALSE  FALSE  FALSE  

 

Table 2.6.e.2: Inversion of the axis in the DriveList, accordingly to AxesGroup palletizer 

robot.  
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 3.Controller configuration files: ECAT 
The “ECAT_Config” file contains the references and the setup parameters to initialize the 
communication between the Controller and the slaves (the Drives) and made the system 
working. 
 
In that chapter the configuration file named “ECAT_Config” will be explained. In particular, 
the procedure to generate the EtherCAT configuration for each drive is presented in such a 
way to made the User able to create the ECAT (ENI) file corresponding to its own Drives 
configuration. 
 

 3.1.Software Requirements 

 TwinCAT 2 NC installed on the PC 

 BonMET SSx4 series XML installed in the TwinCAT folder (C:\TwinCAT\Io\EtherCAT) 
 

 3.2.Procedure to generate ENI files 

 
The following procedure describe how to create the ENI file for the configuration of the 
robotic controller. 
 

 Start TwinCAT system manager; click on Edit > New 
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 On I/O devices right click and select “Append Device”; select EtherCAT > EtherCAT 
and press OK 
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 Rename the new device as “Master” (either by selecting on the tree and pressing 
F2 key or selecting the General TAB and change the Name box) 

 

 
 
 
 

 Right click on “Device 1” and select “Append Box”; choose BonMET SSx4 drive and 
press OK; when prompted on adding NC configuration press “yes”. 
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 Repeat appending box to include as many drives as required by the application (in 
the example 5 drives are configured) 
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 Rename each axis to reflect axis function (not that this name will be used in the 
motion configuration file to refer to the axis). 

 

 
 

 Select NC-Configuration > NC-Task 1 SAF 
 

 Set the interpolation time (in the example 1ms) 
 

 
 

 Save Twincat configuration (File > Save As) 
 

 Select EtherCAT master and EtherCAT tab 
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 Click on Export configuration file and save XML file; rename to 
ECAT_DefaultConfig.xml and copy to the robotic controller. 

 
 
Once the User ends the procedure to generate the configuration file for the communication 
between Robotic Controller and drives, it must pay attention to the names used in the 
MOTION_Config.xml file: they must be equal to the names used in the ECAT_Config.xml, 
otherwise the controller cannot establish the communication link. 
 
If the TwinCAT procedure to generates ENI files ends correctly, no further modification to 
the ECAT configuration file are needed and it can be renamed and load inside the 
controller. 
 
 
 
 
 
 
 
 
 
 
 
 

 4.Controller configuration files: VISION 
As configuration in motion, the vision parameters are also configured in XML file. In XML 
file, the root tag <VisionConfig> includes the list of camera. Each element of the list is 
camera node of which the tag is <camera>. 
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 4.1.Camera List 

In each camera node, the parameters consist of basic information, communication, model 
parameters, and application information. 
 
The following table will describe in detail the parameters of a camera node. 

Up to now, the support camera is described in following table 
 

Camera Type Communication Smart Digital I/O Color 

IFMO2D222 TCP/IP YES YES NO 

Parameters Description Example 

Name Name of the Drive: must be consistent to 

the one reported in the 

ECAT_DefaultConfig.xml file 

Camera 1 

Type The camera type supported by the 

controller. The list of current supported 

camera see in Tab 4.1.2 

IFM 

Protocol (optional) the communication protocol type when 

using the remote camera 

IPv4_TCP 

IP (optional) IP address when using TCP/IP protocol 192,168,80,100 

Port (optional) Port when using TCP/IP protocol 50010 

OperatingDistance The distance from lens to working plane in 

Millimeter (mm) 

10,0 

FocalLength[X,Y] The Focal Length along X and Y direction 

in Pixels 

1050.233 

Center The center position at sensor area in 

Pixels 

348.488 

RadiaDistortCo[1,2] The coefficients of radian distortion 0.039 

 

ImageWidth Image width in Pixels 640 

ImageHeight Image Height in Pixels 480 

ImageDepth The bit number containing one channel of 

a  pixel value 

8 

ImageChannel The Channel number of one pixel, usually, 

1 representing grayscale and 3 

representing color 

1 

PoseTranslation The vector of translation of camera in 

World Reference System  

0,004.8 0,069 10,6 

PoseRotation The vector of rotation of camera in World 

Reference System  

3.05 -0,028 0,045 

DefaultApplication The default application number 1 

Application List Application Data structure See Section 4.2 
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 Table 4.1.2 Supported Camera Types 

 4.2.Application List 

 
Each camera node contains one or more application node ( using tag <application>) 
describing the application parameters. The terminology of application here specifically 
refers to the application of object detection. 
 

Parameters Description Example 

Name The name of application IFM_APP 

Algorithm The Algorithm Type. The Algorithm can be 

set as REMOTE if the camera is smart and 

can processes image by itself. See Table 

4.2.2The supported algorithm  

CHESSBOARD 

AlgorithmData The vector of rotation of camera in World 

Reference System  

See Table 4.2.2 

 

 Table 4.2.3 Supported Applications Types 

The algorithm of application can be selected by user from the following list。。。。. The 

different algorithm types have their corresponding structure of algorithm data. 
 

Algorithm Type Description Data Configuration 

REMOTE Trigger smart camera (such as 

IFM) to process image and 

retrieve results 

The application configuration is 

usually by means of third-part 

software. Thus, the AlgorithmData 

can be omitted。  

CHESSBOARD Detect Regular chessboard The parameters include width and 

height of the chessboard in the 

number of square 

e.s. 

<AlgorithmData> 

<Width>5</Width> 

<Height>8</Height> 

</AlgorithmData> 

Table 4.2.4 Supported Algorithm Types 

 

 5.Controller configuration files: HANDS 
This additional configuration file is needed only if auxiliary axes are used within the used 
application.   
Inside the HANDS configuration files are defined all the parameters of the auxiliary axes, 
as shown in Figure 5.1.1.  
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Figure 5.1.1: HANDS configuration file example  

 5.1.Chain  

Each motor chain used must be declared inside a <Chain> 

field.   

For each Chain, the following fields must be compiled:  
-Proto: contains the type of motor used (in the example three Dynamixel motors have 
been used).  
-Name: the name of the chain.  
-Com: here the connection type of the chain is specified: in the example, the three motors 
are connected with a Serial port and a serial-USB converter to a USB port of the robot 
controller (see Figure 5.1.2).  
-Motors: contains the list of the chain’s motors. For each Motor, must be defined a Name, 
an Id number and a Calibration number for the positioning.  
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Figure 5.1.2. connection example of three DYNAMIXEL auxiliary axes to the robot 

controller  

 

5.2.MOTION_Config additional requirement 
In order to use the auxiliary axes in the robot application, some additional fields must be 
included inside the MOTION configuration file described above.  
First of all, inside the DriveList of the MOTION configuration file, the user must add a new 
DRIVE field for each motor used inside the Chain of auxiliary axes: in the example above 
three auxiliary axes have been configured inside the HANDS configuration file (Base, 
Proximal and Distal), so three Drive must be added inside the DriveList of the MOTION 
configuration file (see Figure 5.2.1).  
 



  59/87 
 

Robot Controller: User Reference Manual 
 

 

Figure 5.2.1: example of additional Drive included inside the MOTION configuration file  

In the new Drive entry must be specified the drive Name, the Type of the motor, the 
Chains to which it belong (DynChain) and the name of the motor (DynMotor). PLEASE 
NOTE that these informations must be the same described inside the HANDS 
configuration file!  
 

After that, the Auxiliary Axes List must be added inside the AxesGroupList field of the 
MOTION configuration file. In the example showed in Figure 5.2.2, the list has been 
added between the Kinematic and BaseOffset fields.  
 

 

Figure 5.2.2 Auxiliary Axes List  

In the AuxiliaryAxesList (AuxAxesList) only the drive name (DriveName) must be 
inserted. The drive names must be the same specified above inside the Drive->Name 
fields.  
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For the usage of PLC blocks related to Auxiliary Axes please refer to section 6.12 of this 
manual.  
 

 6.Graphical User Interface – GUI 

 6.1.Introduction 

The BonMET robot can be controlled both with a graphical user interface (GUI) and with a 
PLC control. The first type of control is suitable to test some movements or configuration of 
the robot, as well as testing if the drivers are working correctly. The second type of control 
is used in order to run a PLC program written as a CodeSys file. 
Once the connection is ready, connect to the BonMET robotic controller by pressing 
“Ctrl+C” buttons or following the path “File->Connect”. 
 

 6.2.GUI aspect 

 
The main page of the BonMET robotic controller is showed in Figure1. On the left part of 
the window there is a tree selector, which allow you to interact to the different part of the 
device: BMC, AXIS, GROUP, CAMERAS or CNC. 
 

 
Figure 5.2.1: GUI’s main page aspect. 
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 6.3.BMC profile: 

By selecting BMC, we can set the Controller Authority between GUI/CNC or PLC program. 
With the second option it's possible to run a PLC program written in the CodeSys 
environment, while the first is used to interact with the robot by using the commands of the 
GUI (described later in this documents). 
Please note that this two options are mutually exclusive: once selected the GUI/CNC 
Controller Authority it won't be possible to run a PLC program, while if the PLC Program is 
selected, the GUI commands will be not available. 
Every time there is a change between these two Authority a password will be requested in 
order to accomplish the change. In the development phase, these two passwords are “GUI” 
(if you want to change the Authority from PLC to GUI) and “PLC” (if you want to change 
the Authority from GUI to PLC). 
 
Below the Controller Authority there are the “Change Network Configuration” and the 
“Reboot device” buttons. By clicking on the first, the window showed in Figure 5.3.1 will 
appear. 
 
In this window the device name will be showed, 
providing you the connected device, its IP address 
and the used mask. If everything is working fine, the 
IP address showed in the box must be the same of 
the controller device that you're using. 
The LAN connectivity and the EtherCAT virtual 
Ethernet port are showed too. 

 
The “Reboot device” button will allow you to reboot 
the device if needed. 

 
Finally, below the described buttons, you can find 
information about the current release, the used 
configuration (.xml) files and the objects that 
describe the robot arrangement (number of axis 
and number of groups). 

 
In the bottom-left corner is displayed the status of 
the last action performed. For example, in Figure 
5.2.1 “SwitchOff Drive1 OK” means that the last 
performed action was a SwichOff on the first drive 
and that it has been performed correctly. The 
explanation of this command will be given later. 
In the bottom-right corner an additional information 
about the connection is given: ONLINE means that 

 
 

Figure 5.3.1: GUI connectivity 
Information. 
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the connection to the robotic controller works correctly, while OFFLINE means that you 
won't be able to use the controller. 
 
 
 

 6.4.AXIS profile 

By selecting AXIS in the left tree selector, a table containing information about each axis of 
the robot will be showed (see Figure 5.4.1). 

 
Figure 5.4.1: AXIS profile overview. 

For each Drive it's displayed the current position and its current status. 

Below the AXIS option in the left tree selector, you can also click on the single axis in order 
to perform a specific action or to obtain information about the axis itself. 

For each drive are available many information regarding the axis state, reference or 
measured position, speed and acceleration, position scaling and movement limits. 

Below this table two folders are available: AXIS JOG and HOMING. The first must be used 
to perform a jog movement, while the second is used to set the home status of the robot. 
In order to perform these action, you have to switch on the drive by clicking on the 
“SWITCH ON” button. If the drive has correctly been switched on, the corresponding icon 
on the left tree selector will turn green, while if there is some error, the icon will turn red. 
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 6.5.Axis Jog: single Drive command profile 

In that profile dashboard, is possible to command and set up a single axis (Drive), enabling 
it and moves back and forward, reset its STATE in case of error and see the setting 
parameters. It is possible also to do HOMING procedure to store the position of the drive 
to be used as zero in the controller works. 

In Figure 5.5.1 is showed an example of jogging movement. 

Figure 5.5.1: Example of jogging movement. The JOG Positive button is being pressed: 
the Drive's State is in “JOG”. 

Once the drive is switched on, the other buttons will be 
available to the user. The “SWITCH OFF” button will 
switch off the drive, the “JOG Negative” and “JOG 
Positive” buttons will provide a jog movement to the 
selected drive (positive or negative directions are 
established by the orientation of the actuator), the 
“GOTO” button can be used to specify a point in the 
workspace that must be reached by the robot with a 
direct movement, the “RESET” button must be used to 
reset the drive when an error occurs. 

Below this buttons the user can modify the jog setting 
by clicking on the “Jog settings” button (Figure 5.5.2): a 
new window will appear, providing the user the actual 
Jog Parameters that can be modified simply by clicking 
on them. 
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Figure 5.5.2: Axis Jog parameters that can be setup. 

If only the Jog speed must be changed, the user can modify the value also by acting on 
the slide bar “Jog speed” on the right of the “Jog settings” button. 

Figure 5.5.3 shows how the Go To command 
works: once the button has been clicked, the 
displayed window will appear. Here the user can 
set the Drive position to reach, as well as the 
maximum speed, acceleration and jerk that must 
be used to perform the movement. 

After settings the parameters, by clicking on the 
“OK” button the robot will perform the planned 
movement. 

 

 

 

 

 6.6.Axis’s HOMING profile 

The HOMING folder can be used to set the home position of the Drive (Figure 5.6.1). After 
moving the drive to the desired position (by using the Jog command for example), the user 
can click on the “START HOMING” button in order to take the actual position as a zero 
position. 

 

Figure 5.5.3:” Go To” command 
example. 
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Figure 5.6.1: Axis’s Homing profile dashboard. 

 

The button “Homing settings” can be used to plan how the homing should be performed. 

Figure 5.6.2 shows the parameters that can be 
modified. The selected method refers to the method 
used to set the homing procedure (the default value is 
35, which corresponds to the Set QUOTA method). 

The homing FAST and SLOW speed refers to the 
speeds that the Drive will follow once it will be forced 
to the homing configuration. They are expressed as a 
percentage of the maximum speed achievable. 

The Homing acceleration can be used to set the time 
to accelerate from 0 to the rated motor speed (as 
explained in the window). 

 

 

 

 6.7.GROUPS profile 

By selecting GROUPS in the left tree selector, the user can check the group axis overview 
in a table similar to the one showed in AXIS.If one clicks on the group name the available 
commands and information for the Group will be available (Figure 5.7.1). 

 

 

Figure 5.6.2: Homing parameters 
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Figure 5.7.1: Groups profile board where is possible to enable and move group of axis (the 
robot). 

 

Both information and commands are different from those specified in a single axis.In the 
information box it is showed the Group State, the Angle Mode (the convention used to 
describe the end effector orientation) which is Euler ZYZ, the position both in the ACS and 
in the MCS coordinate systems and the kinematic parameters of the robot. 

Even if the commands have the same name of the single axis commands, they have some 
radical differences. First of all, by clicking on the “Switch ON” button, each drive configured 
in the group will switch on (as you can see in Figure 5.7.1, since the group 
BONMET_3KG_CF is configured with all the six axis, after switching on the group, each 
axis has been switched on). In the same way, by clicking on “Switch OFF” each configured 
axis will switch off. 

The “Move Linear” button replaces the “Go To” button of the single axis: by clicking on it, 
the window showed in Figure 5.7.2 will appear and the robot will executes a MoveLinear 
command (trajectory defined in the Work Space and actuated using inverse kinematic, pay 
attention to orientation singularities that can drive the robot into error configuration). 

 

In this window, the user can set both the 
position and the orientation that the robot 
should reach. 

Maximum speed, acceleration and jerk can 
be set, just like in the single axis “Go To” 
command. 

Once the movement has been planned, 
click on “OK” to make the robot perform the 
movement. 

If during the movement at least one axis 
reaches a limit position, the movement will 
stop and an error will be set. 

In order to use again the group command, 
the user must first reset each axis that has reached an error state and then switch on 
again the group. For what concerning the group jog movement, the “Jog settings” button 
and the “Jog speed” slide bar are still available and they work in the same way as showed 
in the axis jog movement. For the group movements, it is also possible to select if the 
commanded jog movement should be performed as a linear jog or as a rotational jog in the 
MCS coordinate system. If the linear jog is selected, the jog button will move the robot 
along the X,Y or Z MCS axis, while if the rotational jog is selected the jog will rotate the 
end effector around the X,Y or Z axis (Euler ZYZ convention). 

 

 

Figure 5.7.2: “Go To”, Group move linear 



  67/87 
 

Robot Controller: User Reference Manual 
 

 

 6.8.Cameras Calibration Profile 

Camera Pose Calibration is a necessary process before doing detection of object and 
giving precisely object position and rotation in MCS (Machine Coordinate System). The 
aim of Camera Pose Calibration is to obtain the camera position and rotation in MCS. 
Then it will be possible to transform the object position from the coordinates in camera 
itself to MCS. Once a camera is newly installed in a robot system, a pose calibration is 
supposed to be processed. 
 
The pose calibration can be processed in variable ways, in our vision system, it is provided 
that a process based on a chessboard-based (or pattern-based) in order to facilitate the 
operation. 
 
Here are the prerequisites before making pose calibration: 

• Well-calibrated internal parameters of camera. 
• A 5×8 grid standard chessboard. 
• The chessboard (or other patterns) to be detected by camera can also be reached 

and measured by one of the robots, directly or via a conveyor (es. A straight 
moving belt). 

• If the chessboard has to be transferred by a conveyor, the positive direction of belt 
in MCS is supposed to be known. 

 
The pose calibration can be processed by using our GUI (Graphical User Interface). 
 

 a)Start Window 

In the camera profile, click on [Pose Calibration] to start the step by step procedure. 
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 b)Basic Interfaces 

The list of steps is shown in field 1 indicating the current steps. 

In field 2, it shows the image caught by camera. 

In field 3, it shows the tips instructing what the user should do in current step. 

In field 4. it shows the information of calibration, the results of each steps and final 
calibration results. 

In field 5, the operations can be done here depending on each steps. 

 

 c)Fetch Pattern 

On first step, once the chessboard is put under the camera, click on [Fetch] to trigger 

camera scanning the image to find chessboard. 

If the fetching is successful, the chessboard will be marked some points as anchors which 

need to be measured in future steps. And click on [Next] to continue. 

If failed, please check the image if the chessboard is properly put under the camera so that 

the camera can see every corners. If all of corners can be seen, please check if the 

chessboard is standard as 5×8 grid or if the lighting condition is good enough to recognize 

it. 
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 d)Move Belt 

In step 2, the mission is to select a belt axis if it exists. If there is no belt, select [None] and 
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click on [Confirm]. Then this step can be skipped and belt movement will not be 

considered. 

If a belt is setup, please select the axis of belt and fulfill the belt direction. Then click on 

[Confirm] to confirm the selection. If the selection has mistakes, click on [Reset] to remove 

selection, then make a new selection of belt. After successful belt selection, please move 

the belt to transfer chessboard on the proper position in which the robot can measure all of 

marked anchor points. Then click on [Move Done] to record the belt moving offset. If the 

position is not good enough, the [Move Done] can be re-clicked on to update the belt 

position. 

 e)Measure 

In this step, select, first of all, and confirm a robot used to do measurement. 

 

Then, select a point in the list and measure it. Once the TCP is moved closely enough to 
the target point. Click on [Sample Anchors] to record the position of current point. The 
point can be re-measured to update data until each point is satisfied. 

 

After sampling all of points, click [Next] to continue. 
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 f)Compute 

In this step, click on [Compute] to get calibration results. 

 

Two evaluation values are provided to evaluate the results 

• Shape Compensation Error 

• The Projection Error 

Shape Compensation Error is the value deviation generated when making rectification of 
point shape. The value is suggested not larger than 10%. 

The Projection Error is the average deviation between projection point and real measured 
point. The value is suggested not larger than 1%. 

 g)Update Configuration 

If the calibration result is satisfied, the last step is to update configuration file. The new 
calibrated translation and rotation of camera pose will be written in vision configuration file 
and cover the old values. 

 

 

 

 

 

 6.9.CNC profile 
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The CNC profile is used to move the robot through many points collected directly from the 
workspace. 

After selecting the “GUI” controller Authority from the BMC profile, the user can select the 
CNC profile to access to this functionality. 

As showed in figure 5.8.1, in the CNC profile there are two main buttons: the “Refresh” 
button is used to refresh the main page, while the “New project” button can be used to 
create a new CNC project. 

Below these two buttons there is a table that describes the current CNC project and its 
files. In the example showed in figure 5.8.2 a “test” project has been created with three 
different program files (“Func”, “prog1” and “progDelta”). 

 

 
 

Figure 5.8.1: CNC main profile. 
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From this window is both possible to add a new CNC program file (by right-clicking on the 
table and selecting “Add file”) and to edit one of the already created files (by double 
clicking on the file name). 

After opening the file, a new window will appear with two main fields under the tool bar: 
“PROGRAM” and “DATA”. 

The selection of the workspace point is performed in “DATA”: after moving the robot 
manipulator to the desired point (for example by using the Jog movements), it is possible 
to collect the coordinates of the reached point by clicking on “Teach” (Figure 5.8.2). 

 

 
 

Figure 5.8.2: CNC: collecting points with “Teach” command. 
 
In the showed example of figure 5.8.3, four points has been collected: ap0, ap1, ap2 and 
ap3. After collecting these points, in the “PROGRAM” field will appear the program text 
lines which will command to the robot to move into the collected points (Figure 5.8.4). In 
this example, for each collected point in “DATA”, a corresponding text lines has been 
written in the “PROGRAM” field: “PTP(ap0)” will command to the robot to move from the 
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actual workspace point to the collected point “ap0”, “PTP(ap1)” will command the 
movement to “ap1” and so on. 

 
Figure 5.8.3: CNC program: text line command. 

 
 

 

In the “PROGRAM” field the user can implement also many commands of the C 
programming language, like FOR or WHILE cycles and IF or CASE selector. 

The “Font” provides many option to change the font type and format. 

After writing the program, it can be tested with the tool bar command. First of all, click on 
the “Set” button to enable the written program to be tested (only one program can be run 
attime). The status showed in the bottom part of the window will change to “READY”. After 
that, the “Continue” and “Step” command will become available. 

Click on the “Continue” button to run continuously the written program. Click on the “Step” 
button to run only one line of the written program instead. Click on the “Restart” button to 
restart the program. 

By clicking on “Unset”, the current program won't be enabled anymore. In this way the user 
will be allowed for example to modify the program before testing it again. 
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 6.10.Vision System 

The vision system of our controller supports the use of  IFM O2D222 camera (Product 
Link). The controller makes communication with the camera via TCP/IP protocol. The IFM 
O2D222 camera provides the function of object detection which is remotely processed in 
the camera and sends results and image to our controller via TCP/IP. 
 
IFM provides some software and documentations. Here is the list of necessary resources 
to be referred to in this document: 

• The operating software (http://www.ifm.com/ifmus/web/dualis-download.htm) 
• The installation guide (http://www.ifm.com/mounting/706370UK.pdf) 
• The programming manual (http://www.ifm.com/mounting/704420UK.pdf) 

 
The setup of hardware are independent to our controller. Thus please refer to the 
installation guide. 
 
Before the using of camera, it is necessary to correctly setup the camera application 
depending on the specific task. The application setup is via the official operating software 
provided by IFM of which the downloading link can be found on website: 
 
 
After downloading and installation, the first step is to connect the camera that is supposed 
to be correctly setup. 

• From menu Connections (1.) → [IP address….], open the interface of connection as 
following: 

• The input fields for the IP address appear (2.) 

http://www.ifm.com/products/us/ds/O2D222.htm
http://www.ifm.com/products/us/ds/O2D222.htm
http://www.ifm.com/ifmus/web/dualis-download.htm
http://www.ifm.com/mounting/706370UK.pdf
http://www.ifm.com/mounting/704420UK.pdf
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• Enter [IP address](3.) 
• Click on [Connect] (4.) 

 
The factory setting of network parameters is: 

 
 
 
 
 
 
 
 
If the 

factory setting has been modified, the network parameters can be found and modified 
directly on device. Refer to Section 5.3.6 in the programming manual. 
 
 

 a)Application Setup 

 
After successful connection, click on applications] (1.), 
In field 2, the application can be modified. 
In field 3, there are some global administrations. 
In tabs [General] and Network parameters], the settings can be as the user-defined 
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depending on working environment. 
In tab [Global sensor settings], the settings must be as following. 

In tab [Process interface], the settings must be as following. 

 
Create new applications 
 

 
• Select the folder (1.) 
• Click on [New] (2.) 
• The pop-up window "New application" (3.) opens. 
• Enter the name of the application (4.) 
• Click on [OK] 

 
The steps of setting application should follow: 

• Image quality 
• Model definition 
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• Process Interface 
• Trigger configuration 
• Function test 

 
The procedure of steps can refer to the official installation guide on section 8.7 – 8.13 in 
the installation guide. 
 
In particular, to match the camera diver in our controller, the Process Interface must be set 
as following: 

 

 6.11.PLC Vision System’s Function Blocks (FB) 

 a)Vision_CameraBuild 

This function block enable a configured camera. 

Vision_CameraBuild 

Inputs Enable Enable camera at rising edge 
or Disable camera at falling 
edage 

 Camera ID Camera Identification 

Outputs Status Effective state of camera 

 Error The error signal 

Error ID Error identification 

 

 b)Vision_SetApplication 

This function block set a configured application to camera 
 

Vision_SetApplication 

Inputs Execute Start setting at the rising edge 
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 Camera ID Camera Identification 

Application Application Number 

Outputs Done Setting completed 

 Busy Setting in process 

Error The error signal 

Error ID Error identification 

 c)Vision_ObjectDetection 

This function block triggers camera to do object detection. The detection can be done in 
periodic with a wait period. The time stamp and detected object number will return. 
 

Vision_ObjectDetection 

Inputs Execute Start setting at the rising edge 

 Camera ID Camera Identification 

Periodic Detect in periodic or not 

DelayMs Delay in millesecond between 
two detections 

MatchThreshold The objects in two continuous 
frame will be probably identified 
as the same one. 

Outputs Done Detection completed 

 Busy Detection in process 

TimeStamp The triggering time instance in 
microseconds 

ObjectNumber Detected object number 

Error The error signal 

Error ID Error identification 

 
If the “Periodic” input of the Vision_ObjectDetection function block is set to TRUE, the 
detect trigger will be set periodically according to the value of the “DelayMs” input. The 
suggested value for this input is 250 ms (minimum time), because in this way the total 
time between two trigger will be reduced.   
 

To compute a correct value to be set as “MatchThreshold” input, the user must take into 
account both the total time between two trigger events and if the object to be detected has 
being moved on a conveyor belt or similar device. The MatchThreshold value is used to 
consider the distance between the objects detected in two consecutive frames, and in 
particular is used to discriminate whether the detected object are the same object (moved 
according to a conveyor belt or similar device) or two different objects.  
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The total time between two trigger events is computed as the sum of the camera 
evaluation time and the delay between two detections (“DelayMs” input). The camera 
evaluation time should be provided by the camera data sheet or by the user manual: the 
IFM camera user manual provide as typical values of evaluation time 50-800 ms. 
However this evaluation time depends on many factors, like the object size and 
orientation, the number of object detected, the smoothing degree and so on..  
 

To evaluate the distance between two frames, a correspondence between the camera 
field of view measured in meters and the same field of view measured in pixel is needed. 
The sensor reference manual should provide all the data needed for the computation: as 
an example, the user manual of the IFM camera provide these tables, in which the 
camera field of view has been related to the camera operating distance for different type 
of cameras:  
 

 
 

MatchThreshold computation example 

 

Let’s suppose to have a conveyor belt transporting the object to be detected at a constant 
speed of 0.05 m/s (BeltSpeed = BS =0.05 m/s).  
 

Suppose to have installed a O2D222 camera at 300 mm from the conveyor belt: from the 
tables above, the camera field of view can be interpolated as 198x141 mm (0.198x0.141 
m). Since the field of view is about 640x480 pixels, we can obtain the pixel to meter ratio 
(PxToM) as:  
 

PxToM = 640 / 0.198 = 3232 pixel/m  

 

The total time between two frames (TotalTime) can be computed as   
 

TotalTime = DelayMs + Max suggested evaluation time = 0.250 + 0.800 = 1.05 s  
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For the computation we have considered the maximum value between the indicated 
typical values of the evaluation time.  
If the “Periodic” input is set to FALSE, the total time must be computed by considering the 
time interval between two trigger events set by the user.  
 

Finally the match threshold (MatchThreshold) can be computed as:  
 

MatchThreshold = BS * TotalTime * PxToM = 0.05 * 1.05 * 3232 = 170 pixel  

 

Since this value is characterized by many measurements uncertainty (like the evaluation 
type, as mentioned above), it could be useful to use as a “MatchThreshold” input to the 
Vision_ObjectDetection FB a bigger value (like 200 pixel).  

 

 d)Vision_ReadCameraStatus 

This function block returns the state of camera. 
 

Vision_ReadCameraStatus 

Inputs Enable Get data continuously while 
enabled 

 Camera ID Camera Identification 

Outputs Valid True if valid outputs available 

 Disconnect in Disconnect state while true 

Idle in Idle state while true 

ReleaseThread in ReleaseThread state while 
true 

Busy in Busy state while true 

ErrorState in Error state while true 

Error The error signal 

ErrorID Error identification 

 

 e)Vision_Reset 

This function block resets the status of camera when error happens. If the camera fails to 
be connect, the function block will set camera state to disconnect. If any error occurs 
during operation. The camera will be reset to idle state. 
 

Vision_Reset 

Inputs Execute Start reset at the rising edge 

 Camera ID Camera identification 
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Outputs Done Reset completed 

 Busy Reset in process 

Error Error signal 

Error ID Error identification 

 f)Vision_ReadObject 

The function block return the information of object in current object queue. 

Vision_ReadObject 

Inputs Enable Get the object data of 
continuously while enabled 

 Camera ID Camera Identification 

Object ID Object Identification 

Outputs Valid  

 TimeStampUs  The instance in which the 
object is considered as 
detected 

Position The position of object in MCS 

Velocity The velocity of object in MCS 

Error Error signal 

Error ID Error Identification 

 g)Vision_ReadObjectQueue 

This function block updates the object id list queue and returns the number of current 
detected object. 
 

Vision_ReadObjectQueue 

Inputs Enable Get data in object queue 
continuously while enabled 

 CameraID Camera identification 

ObjectIdList The point to object list array 

ListMaxSize The maximum size of object 
list array 

Outputs ObjectNumber The current number of object 
in the queue 
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 7.Trajectory Generator 
In the following chapter the main purpose of the trajectory planning and generation 
available on the controller will be explained. 
 
The motion of the robot can be divided into two main area: DIRECT movement, in which 
the motion is planned in the motors space (JOINT SPACE -> ACS coordinate system) and 
doesn’t take into account the workspace feasibility of the planned movement, or a LINEAR 
motion, planned in Cartesian space (real world, (X,Y,Z) SPACE -> MCS coordinate 
system). 
 

Direct Movement
 Acs Coord. System
 Joint Space (space of the motors, 

coordinates are degrees or radians)
 Direct move. Good for LARGE 

movement

Motion Definition

Linear Movement
 Mcs Coord. System
 Work (Cartesian) space (space of the 

world, application (x,y,z), 
coordinates are in meters)

 Linear move. Good for SMALL but 
very precise movement (singularity 
problem)

 
 

Figure 6.1: Motion types. 
 

It is preferable to use a DIRECT movement for long movement because it allow to avoid 
the singularities problem typical of the linear movement. The motion is planned in the 
space of the motors (degrees/radians). 
To plan a precise movement in the application space (Work Space -> Cartesian Space), 
the LINEAR movement it the one must be used, taking into account the problem of 
singularities (handled in the kinematic models). 
 
To avoid the stop at the end of each segment of motion, blending is available in such a 
way it’s possible to reschedule de path with small modification to prevent the stop of the 
robot and start the next movement keeping the speed wanted.  
There are several possibilities to blend movements taking into account the type of the 
motion (direct, linear and combinations among them). 
 
 



  84/87 
 

Robot Controller: User Reference Manual 
 

 

 7.1.Blending two Mcs movements: Linear/Circular to Linear/Circular 

To connect two movements in the Work Space (Mcs coord. system) there are four possible 
case regarding the actual motion type and the next one (entering): 

 Line --> Line 

 Line --> Circle 

 Circle --> Circle 

 Circle --> Line 
 
An example of how the blending works is the Figure 6.1.1: 

 
 

Figure 6.1.1: Blending between lines in Mcs. 
 
The parameter that drive and define the blending is the OVERLAP: is a normalize 
percentage of the starting and ending point of the blending on the length of actual and next 
movement.  
 
The value of overlap can vary from 0 to 2, where 0 means no blending and 2 means full 
blending (starting from half the current movement and ending at half of the next 
movement). 
 
The percentage of the overlap is computed as follows for actual and next movement 
(naming ovl_par the parameter of the blending): 

 Actual movement: overlap_actual_move := 1.0 – ((ovl_par*0.5)/2.0); 

 Next movement: overlap_next_move := (ovl_par*0.5) /2.0; 
This means that using blending parameter i.e. 1.0, the attaching point on actual movement 
is the 75% of the actual length, and the ending point is the 25% of the next length. 
The value 2.0 (maximum allowed) means blending both actual and next at the 50% of the 
length. 
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The blending is also possible between Circular movements and Linear or Circular yet with 
the same concept of overlap also with circle in Mcs. 

 7.2.Blending two Acs movement: Direct to Direct 

It is also possible to connect two direct movements (in the Acs coordinate system) in such 
a way to avoid the stop of the mechanism after finishing one movement. 
To do this the trajectories of the motors are rescheduled, scaling all the path of each drive 
with respect to the slower one, in this way the motors are synchronous and all starts and 
ends at the same time. 
 
The aim of the rescheduling is to guarantee constant speed for the major part of the 
motion, taking into account the acceleration/deceleration and jerk boundaries that define 
the speed profile.  
 

 7.3.Blending Acs/Mcs to Mcs/Acs movement: mixed blending 

To conclude the possibilities of linking movements with the Trajectory Generator system, is 
present also blending between mixed type of movement: Acs/Mcs and Mcs/Acs. 
 

 a)Blending starting from Acs (Direct) movement to Mcs (Linear) 

The junction among the two movement is based on the switching off 
the Acs motion profile and a polynomial curve that actuate the 
connection with the next Linear movement.  

The beginning of the blending is done in Mcs (coord. system of the 
arrival movement) using always the percentage of the length of both 
actual and next path to schedule the attaching point. 

Please take care that the blending connection is made in Mcs 
coordinates and can drive the robot through singularities positions of 
the orientation and kinematic. 

 b)Blending starting from Mcs (Linear) movement to Acs (Direct) 

The symmetric condition to the one presented before is the scheduling 
of a connection between a Linear movement to a Direct one. 

In this case the motion is planned scheduling a trajectory in the motors 
reference system, passing at the specific point of the Linear path 
corresponding to the blending percentage, to Acs coordinates. 

 

Both of the two reference system blending mechanism prevent the robot passing through 
the via point (connection between the two paths), but this is necessary to ensure the 
continuity at speed level and avoid discontinuities that can be dangerous or damage the 
system. 
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The method following the PLCopen standards, the following combination of transition 
parameters and blending type are actually implemented and allowable: 

 

 c)Transition mode: MC_TRANSITION_MODE 

TRANSITION MODE PARAMETER STATUS 

tmNone None available 

tmStartVelocity Keep the velocity used at the end 
of the first movement 

not available 

tmConstantVelocity Keep a constant velocity not available 

tmCornerDistance Distance from the corner on the 
path 

not available 

tmMaxCornerDeviation Distance from the curve computed 
to the corner 

not available 

tmRelativeCornerDistance Percentage of the overlap on the 
total length of the path to be  

blended 

available 

 


